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Abstract:  
 
 
The design and implementation of a Programmable Automatic Voltage Regulator 
(PAVR) with improved precision, suitable hysteresis, and anomaly protection are 
proposed in this study. The local systems currently in use are imprecise and have the 
issue of cycling between two output voltages, which results in surges at the output that 
can harm expensive devices. They need to be avoided, therefore power-voltage 
stabilisation, output wave rate minimization, and constant power-voltage to the 
instruments are required while the load fluctuates. It necessitates the preservation of 
constant voltage and quick response to abrupt changes in input voltage and load. This 
paper defines the shortcomings and  introduces  a  new  system  in  the tolerable   and   
substantial   stable   of   220V   with   4.5%    output   accuracy   for   any deviation of 
input supply voltage within 100V-340V. To control the whole system automatically a 
microcontroller is used with some protection devices where  to detect fault and the 
circuit implementation in this system are simple and flexible than conventional analog 
control  circuitry. A simulation for both circuit and program has been accomplished for 
establishing better performance. 

 
Keywords: Programmable Automatic Voltage Regulator (PAVR), Hysteresis, 

Microcontroller, Protection, Simulation. 

 
Introduction 

 

AC power supply by Power Development Board (PDB) in Bangladesh is subjected to 

variation from time to time. Moreover in rural areas supply voltage remains lower than 

specified most of the times. This poses a considerable threat to the sophisticated electronic 

devices. For that reason, many important electric machine or electric equipments may 

destroy. Power quality related problems, in particular voltage sags [1-3], surge [4] and 

brownouts have a major negative impact on industrial productivity. This appears to be true 

for both industrialized as well as developing nations. So ensuring the input voltage to  

remain in a tolerable pre-specified limit has become a necessity in rural as well as some 

urban areas. In order to save these we need to use the Automatic Voltage Regulator [1,5,6]. 

An AVR is an electronic device that automatically regulates a variation of input voltage at a 

certain desired level to load [1,5,7]. The voltage of main power supply may be affected by 

various troubling physical factors [1,3], so that special regulating equipment is required to  

keep the voltage steady. In replace of AVR, Programmable AVR is more flexible, easy to 

modify and the best for good precision and hysteresis [5,8-11]. 

The existing systems like servo-stabilizers [12], CVTs [13], Ferro resonant regulators 

[14], thyristor ac regulators [15], tap changers [16-19] and the electronic regulators 

[5,6,20,21] are the available means for voltage regulator. Here the performances of existing 

commercially available technologies are compared by this system regarding response, faults 

handling, precision, efficiency and other important parameters. 
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It is essential that the supply ac voltage is needed to operate automatically [7-10] due to 

the interconnections among the systems in modern age. The electronic control circuit [7-10] 

may be utilized to get the desired output which is very simple, flexible, reliable and cost  

effective. 

AVR mainly functions to measure and regulate the input voltage for producing the 

stable output and to provide the Protection against sag, surge, spike, impulse, notch, brown 

out, over voltage, under voltage, over current and hysteresis to the sophisticated equipments 

and machineries. In this system, the whole operations are implemented by a microcontroller 

[22]. Microcontroller here performs all actions in accordance with the program maintaining 

proper precision and hysteresis as we desire and the undesired input transitions are handled 

by the AC protection devices. The whole proposed design is illustrated in the following 

block diagram (Figure-1). 
 

Figure-1: Block diagram of PAVR 

A multi-tapped transformer [7,16-19] with input supply and switches connected in 

primary and in secondary respectively to obtain regulated and stabilized output voltage at 

the load side is used. Here microcontroller plays the important role to decide and hence to 

control the switches through which secondary tap carries the power from input to load with 

a steady voltage. This system also provides the protection against surge, spike, lightning,  

overvoltage and excess current [1,3-5] by adding AC breaker (MCB) [23,24], Automatic 

Voltage Switcher (AVS) [25] in the Input line. In the upcoming sections the designing 

procedure with simulations, programming, the control operation of microcontroller and 

performance analysis will be discussed. 

 
1. Designing Procedure and Discussion 

 

 Description of Circuit Design 

 
As the designing commitment which is to stabilize automatically a large range (100V- 

340V) variation of input voltage at a normal prescribed level output voltage (Table-1) with 

a great precision. For this the voltage regulation of input supply is designed which is 

regulated automatically in such a way that when the input voltage varies, the output voltage 

will remain stable at a constant value. To achieve this, a microcontroller has been 

programmed is such a way that when the dc input to microcontroller varies in accordance 

with the variation of input voltage, microcontroller will operate the suitable switch to get a 

regulated output from desired transformer tap. Table-1 represents the designing 

configuration of the multi-tapped transformer. 

Firstly, the microcontroller compares a converted variable DC voltage which is found 

by stepped down the ac supply voltage with the range, which is shown in Table-2 and is set 



International Journal of Engineering Sciences Paradigms and Researches (Volume 47, Issue: Special Issue of January 2018)  

ISSN (Online): 2319-6564 and Website: www.ijesonline.com 

283 

 

 

 

in the memory of the microcontroller. The voltage range for the program has been chosen 

in such different manner for letting switches functioned to select the different taps for 

getting desired output of around 220V AC (Table-2). Thus the stable output voltage occurs 

at the output of this designed regulation system for any short of variation of input voltage  

automatically. The whole schematic of the PAVR is shown in Figure-2 and Figure-3. 
 

 

Figure-2: Schematic diagram of PAVR (Part-1) 
 

 

Figure-3: Schematic diagram of PAVR (Part-2) 

 
 Simulation Procedure 

 
To determine the accurate level of voltage for designing of switching and making the 

microcontroller program this circuit has been simulated using PSPICE Simulator [26,27].  

The operation of switching of PAVR at different level of input voltage is observed as well. 

Here, for input supply voltage of 130V, the switching operation is shown graphically in 

Figure-4 where the switch under PB0 and Q0 is “ON”. At any input voltage within 100V- 

340V, one and only one switch is activated at a time as defined in the program. 
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Figure-4: Simulation for 130V Input [26] 

 
 Flowchart description 

 
The microcontroller program [22] of the PAVR is designed and functioned, as the 

following flowchart (Figure-5), to measure the received DC voltage and then to compare 

with the prescribed range stored in the microcontroller memory and finally to obtain a 

decision for the output. In the flowchart, it is also shown that when the received DC input is 

out of the range (i.e. above 5V and below 1V), microcontroller will operate “No Operation 

(NOP)”. That means, the PAVR will remain “OFF” during excess high and low voltage AC 

supply to protect the devices and equipments from damaging. Here the increasing and 

decreasing of DC input voltage are given orderly to maintain the hysteresis properly. 
 

Figure-5: Flowchart for the program of microcontroller operation 

 
 Description of Program Operation 
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The program that was designed for the PAVR has been simulated using PIC Simulator 

IDE software [28]. PIC Simulator IDE is a basic complier, assembler, disassembler and 

debugger for microchip family PICmicro. Firstly, the microcontroller has to be selected to 

load the program. Then the simulation has to be run. The sequences of operation have to be 

executed as follows. 

Option>Select Microcontroller 

Tools>Assembler 

File>open/PAVR.asm 

Tools>Assemble & Load 

Simulation>Start 

Tools>Microcontroller View 

Tools>8×LED Board 

The overview of simulation is presented by Figure-6 with PIC Simulator IDE interface. 

In this figure, the PORTB0 is displayed as ON when the input voltage is in the range of 

1.0V-1.5V (2Ch-0Fh). 
 

 
Figure-6: The simulation interface of PIC Simulator IDE with output Display [28] 

 
 Description of Microcontroller Operation 

 
A PIC16F876A CMOS FLASH-based 8-bit microcontroller [22] (Figure-7) is used to 

control the whole system which is more reliable, simple and flexible than conventional 

analog control circuitry. It features especially Self-reprogrammable under software control, 

2 I/O pins & 3 I/O ports, 256 bytes of EEPROM data memory, 2 Comparators, 5 channels 

of 10-bit Analog-to-Digital (A/D) converter, Programmable code protection, Power-saving 

Sleep mode, Selectable oscillator options and In-Circuit Debug via two pins. 
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Figure-7: Pin diagram of PIC16F876A Microcontroller with program placing. [22] 

 
An assembly language program is loaded in the microcontroller memory (Figure-7) that 

configures the A/D module, comparator module and I/O ports, and sets different registers of 

the memory with the different range of digital code (Table-3). In the program the registers 

are assigned by any arbitrary names to make the program more readable. 

Here port-A is used as input port and port-B as output port. Firstly, microcontroller 

receives the DC input corresponding to supply AC input from stepped-down transformer at 

RA1 of PORTA. And then it is compared with the ranges that are set in the memory of 

microcontroller in the form of code via an A/D converter and a comparator. After that it 

makes anyone of the output pins (RB0-RB7) of PORTB HIGH corresponding to the range, 

as mentioned in Table-2, which in turn activates a respective switch to get the regulated 

output from the transformer. Here a constant voltage level is maintained although the input 

voltage level goes high than the constant desired level (Table-4). To sense this change, the 

microcontroller periodically checks terminal voltage and compares this with defined 

reference voltage levels. For designing purpose the reference voltage and code as a range 

has been calculated to corresponding pins of PORTB. This is shown in Table-2 and Table- 

3. 

 
Table-1: (For the Design of Multi-tapped Transformer) Output Voltage Range 

corresponding to Input Range and Transformation Ratio at different Taps at Normal Input 

Voltage of 220V 

 

Tap Input Desired Transfor Output Voltage Output Voltage 

No. Supply Regulated mation Range(Calculate Range for 
 AC Voltage Output Ratio d) for Normal Normal 
 Range Voltage (Calcula Input (220V) Input(approx.) 
  Range ted)   

T0 100V-130V 210V-230V 1.913 401.73V-439.99V 400V-440V 

T1 131V-160V 210V-230V 1.517 318.57V-348.91V 320V-350V 

T2 161V-190V 210V-230V 1.257 263.97V-289.11V 265V-290V 

T3 191V-220V 210V-230V 1.073 225.33V-246.79V 225V-245V 

T4 221V-250V 210V-230V 0.936 196.56V-215.28V 195V-215V 

T5 251V-280V 210V-230V 0.830 174.30V-190.90V 175V-190V 

T6 281V-310V 210V-230V 0.746 156.66V-171.58V 155V-170V 

T7 311V-340V 210V-230V 0.677 142.17V-155.71V 140V-155V 



International Journal of Engineering Sciences Paradigms and Researches (Volume 47, Issue: Special Issue of January 2018)  

ISSN (Online): 2319-6564 and Website: www.ijesonline.com 

287 

 

 

 

 

Table-2: Selection of output pins, Switches and Transformer Taps for 

the prescribed input DC voltage range corresponding to input AC supply voltage range. 

 

Input 

Supply AC 

Voltage 

Range 

Reference 

Input DC 

Voltage Range 

for increasing 

Reference 

Input DC 

Voltage Range 

for decreasing 

Output 

Pin 

Selection 

Switch 

Selection 

Transformer 

Tap 

Selection 

100V-130V 1.0V-1.5V 0.9V-1.5V RB0 S0 T0 

131V-160V 1.5V-2.0V 1.4V-2.0V RB1 S1 T1 

161V-190V 2.0V-2.5V 1.9V-2.5V RB2 S2 T2 

191V-220V 2.5V-3.0V 2.4V-3.0V RB3 S3 T3 

221V-250V 3.0V-3.5V 2.9V-3.5V RB4 S4 T4 

251V-280V 3.5V-4.0V 3.4V-4.0V RB5 S5 T5 

281V-310V 4.0V-4.5V 3.9V-4.5V RB6 S6 T6 

311V-340V 4.5V-5.0V 4.4V-5.0V RB7 S7 T7 

 

Table-3: Hexadecimal Value of digital code equivalent to prescribed DC voltage range 

corresponding to AC input and PAVR output voltage. 

 

Tap 

No. 

Input 

(Volt AC) 

PAVR 

Output 

(Volt AC) 

Equivalent DC 

Level for 

Microcontroller 

Hexadecimal 

Value 

(Initiating 

Hexadecimal 

Value 

(Tolerance 
   (ADC) range) range) 

T0 100V-130V 210V-230V 1.0V-1.5V 2Ch-0Fh 31h-0Ah 

T1 131V-160V 210V-230V 1.5V-2.0V 49h-2Ch 4Eh-27h 

T2 161V-190V 210V-230V 2.0V-2.5V 66h-49h 6Bh-44h 

T3 191V-220V 210V-230V 2.5V-3.0V 83h-66h 88h-61h 

T4 221V-250V 210V-230V 3.0V-3.5V A0h-83h A5h-7Eh 

T5 251V-280V 210V-230V 3.5V-4.0V BDh-A0h C3h-9Bh 

T6 281V-310V 210V-230V 4.0V-4.5V DAh-BDh DFh-B8h 

T7 311V-340V 210V-230V 4.5V-5.0V F8h-DAh FDh-F5h 

 

Table-4: Experimented Analog DC input for ADC of Microcontroller 

and Regulated AC Output Voltage for typical AC Input Supply 

 

Typical 

AC Input 

Voltage 

Supply 

Vin DC to 

RA1 

Output 

at 

Output for Normal 

Input (220V) at 

different tap 

Desired 

Regulated 

Output 

Practical 

Regulated 

AC Output 

115V 1.326923V RB0 420.86V≈420V(T7) 220V 219.55V 

145V 1.8125V RB1 333.74V≈335V(T6) 220V 220.80V 

175V 2.302632V RB2 276.54V≈275V(T5) 220V 218.75V 

205V 2.795455V RB3 236.06V≈235V(T4) 220V 218.98V 

235V 3.29V RB4 205.92V≈205V(T3) 220V 218.98V 

265V 3.785714V RB5 182.60V≈185V(T2) 220V 222.84V 
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295V 4.282258V RB6 164.12V≈165V(T1) 220V 221.25V 

325V 4.779412V RB7 148.94V≈150V(T0) 220V 221.59V 

 

2. Performance Analysis 

 

This system has been experimented practically after designing. Here for some typical 

AC input voltage supply, the regulated output approximate to desired level is found that is 

shown in Table-4. From this table, it is clearly revealed that this PAVR is able to regulate 

any variation of input voltage of a system within 100V-340V at a stable range of 210V- 

230V and also to defend the system from damage due to extreme decrease and increase in 

AC supply voltage which is out of the range of 100V-340V. In Figures below present some 

performance curves of PAVR. Figure-8 shows the desired response curve of PAVR which 

is produced from the desired output voltage (210V-230V) for any input supply voltage 

within range of 100V-340V. In Figure-9, a typical input-output voltage characteristics 

curve of PAVR is put on view of the regulated output voltage that is near about 220V AC 

(Data in Table-4). 

The Figure-10 exhibits a practical input-output voltage characteristics of PAVR for 

random supply. In this response curve, it confirms the design requisition of a stable output  

in range of 210V-230V as the regulation of any change in AC supply voltage within 100V- 

340V, and the protection any system from spoiling due to low voltage i.e. below 100V and 

high voltage i.e. above 340V. A hysteresis curve, given in Figure-11, shows the hysteresis 

behavior of PAVR during the operation of switches at the transition of different ranges of 

input supply voltage. It is needed to maintain properly to prevent the frequent vacillation of 

switching between “ON” and “OFF”. 
 
 

 

Figure-8: Desired Response Curve of PAVR 
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Figure-9: Typical Input-Output Voltage Charactesistics of PAVR 

 

 
Figure-10: Practical Input-Output Voltage Characteristics of PAVR for Random Supply 

 

 
Figure-11: Hyteresis Curve [5] 
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3. Conclusion 

 

It is evident from the architecture and discussion above and the comparison of my 

proposed proprietary PAVR with some other popular current AVR systems in Table 5 that 

it outperforms all other systems. It can be designed to maintain suitable precision and 

adequate hysteresis throughout a wide range of input variation because it is primarily 

programmable. Here, it is confirmed that there is protection against excessively high and 

low voltage and current, which is essential for highly advanced electrical and electronic 

equipment. It should be noted that the PAVR is significantly less expensive than other 

systems because it uses a microcontroller instead of discrete electronic components and 

straightforward protection mechanisms. Therefore, the circuit design and implementation 

are very much easy, flexible and the efficiency of this system is good enough as well. 

According to market comparison study, the commercially available AVR [29] has a three 

to four step stabilization of the input variable voltage where the output becomes a big 

changing stable value within a prescribed range that is not an absolute design to get an 

output precised. For this reason in my research the way has been adopt to make the system 

for getting the precision output within in a large variation of input is the design of the 

main transformer having a many number of taps in the secondary winding side of the 

transformer maintaining a small turn difference between two adjacent taps. PAVR is 

applied to all electrical and electronics equipments especially in communications and 

precision instruments of manufactories. 
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